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PROFESSIONAL EDITION RELEASE NOTES

NI Circuit Design Suite

Version 10.1

These release notes contain system requirements for NI Circuit Design
Suite 10.1, and information about product tiers, new features,
documentation resources, and other changes since NI Multisim 10.0.1 and
NI Ultiboard 10.0.1.

NI Circuit Design Suite includes the familiar NI Multisim and NI Ultiboard
software products from the National Instruments Electronics Workbench
Group. The NI Multisim MCU Module functionality is now included with

NI Multisim.
Contents
Installing NI Circuit Design Suite 10.1....c..coccoveriininiinininiinieiecee, 2
Minimum System Requirements ...........cccceceevereenenennenenecneneenn 2
Installation INStIUCHONS. ........ooivueieieieieire e 2
Product ACVAtION .......couivuiviirieieieiciceet e 3
What’s New in NI Circuit Design Suite 10.1......ccccceveninieninniininienens 3
The NI Multisim Automation APL..........cccccocovviniininininiiiinn 3
Enhancements to NI LabVIEW Instruments in NI Multisim .......... 4
Input and Output InStruments ..........coceveevuereereneniieneeneenennee. 5
Continuous Data from Output Instruments ..........c.ccceceeveenuennee. 5
Affecting the Time Step and Interpolation Method.................. 5
Increased Quality and Breadth of the Component Database ........... 6
New Components from Leading Manufacturers ...................... 6
Generic Power Simulation Parts...........c.ccocceeeiviininnnincnne. 6
Extended SPICE Modeling Capabilities..........c.cccoererrenenueniennene 6
Redesign and Improvement of the NI Multisim
SPICE PAISEI......coiieieriiiienieeienitetenieete ettt st siens 6
Improved SPICE Model Error Reporting.........cccccoceeverceeenen. 7
Improvements to Cadence® PSpice® Compatibility................. 7
NI UPdate SEIVICE.....couveieruiiiiniieiieieenie ettt 8
Windows Vista COmpliant..........ccoeevereriieneniienenieneneenenienennens 8
Better Storage of User Fields from the Master Database ......... 8

¢ NATIONAL
INSTRUMENTS'

ELECTRONICS WORKBENCH GROUP



Support of TDMS Data Files........cccoevieveiiinieniiiiiiieeiecieeeeeeee 8

Files are Compatible with NI Circuit Design Suite 10.0.x............... 8

New Font Rendering in NI Ultiboard............cccceevveiriienniieniennienieens 8

LOCAIZAION ..c.vveeniie ettt 9
Product Tier DetailS........cceeviiriiiniinieiieeeesieeieeeie et s 9
DOCUMENTALION. ....euvieiiieiieeieerite ettt ettt et e st e st e sneeabeenee 16

Installing NI Circuit Design Suite 10.1

This section describes the system requirements and installation procedures
for NI Circuit Design Suite.

Minimum System Requirements

To run NI Circuit Design Suite 10.1, National Instruments recommends
that your system meet the following requirements:

Windows 2000 Service Pack 3 or later, Windows XP, Vista, or
64-bit Vista.

Pentium 4 class microprocessor or equivalent (Pentium III class
minimum).

512 MB of memory (256 MB minimum).

1.5 GB of free hard disk space (1 GB minimum).

Open GL® capable 3D graphics card recommended (SVGA resolution
video adapter with 800 x 600 video resolution minimum, 1024 x 768
or higher preferred).

To develop custom LabVIEW based instruments for use in Multisim,
LabVIEW 8.2.x or 8.5.x is required.

Installation Instructions

The NI Circuit Design Suite 10.1 installer installs all products in the suite:
NI Multisim and NI Ultiboard.

National Instruments recommends that you close all open applications
before you install NI Circuit Design Suite.

Unless you specify another location during installation, the NI Circuit
Design Suite installation program copies files to <Program Files>\
National Instruments\Circuit Design Suite 10.1 after you
complete the following steps:

1.
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Insert the NI Circuit Design Suite CD into the CD-ROM drive. If the
CD startup screen is not visible, select Run from the Windows Start
menu and run setup . exe from your CD drive.

Follow the instructions in the dialog boxes.

2 ni.com



Product Activation

When you run a product in NI Circuit Design Suite for the first time, it will
prompt you to activate a license for that product.

If you do not activate a valid license, the product will run in Evaluation
Mode and continue to prompt you to activate a license on each subsequent
run. Evaluation Mode is valid for 30 days following the first run of the
product.

For information about how to activate your software product, please refer
to the Activation Instructions for National Instruments Software Note to
Users included with your NI Circuit Design Suite 10.1 package.

What’s New in NI Circuit Design Suite 10.1

This document describes the following feature additions or improvements
to NI Circuit Design Suite 10.1:

e The Multisim Automation API

*  Enhancements to NI LabVIEW instruments in Multisim
* Additions to the component database

»  Extended SPICE modeling capabilities

* NI Update Service

*  Vista compliance

*  Support for TDMS data files

*  File compatibility with NI Circuit Design Suite 10.0.x

*  New font rendering in NI Ultiboard

The NI Multisim Automation API

The NI Multisim Automation API allows the automation of simulation and
analyses through a COM interface. This is useful when a number of
simulation runs are required with different circuit settings. Examples
include such tasks as component analysis, stress analysis, and fault
analysis.

The Multisim Automation API lets you programmatically control a
Multisim simulation without needing to view Multisim. Clients written in
any COM-aware programming language, such as NI LabVIEW, Visual
Basic, or C++ can access Multisim through this interface.
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Through the API, you can:
*  Open and close an existing circuit.

e Optionally inject a signal in place of an existing voltage or current
source.

e Start, stop, and pause simulations.

* Read out simulation results from an existing static probe.

¢ Enumerate the components in the schematic.

*  Replace components with components from the database.

*  Get and set the values of resistor, capacitor, and inductor components.
e Enumerate variants.

*  Get and set the active variant for simulation.

e Generate reports on the schematic, including a bill of materials and a
netlist report.

e  Produce an image of the circuit.

@ Notes Simulation settings used during API control simulations are taken from the
Transient Analysis settings of the chosen circuit. Any changes to the Interactive Simulation
settings are ignored.

The API can only change and replace components on the top level of a design; components
in sub-circuits and hierarchical blocks cannot be altered.

Multisim component replacements may not always have the expected result—they should
always be tested in an interactive session of Multisim to make sure that the behavior is what
is required.

Multisim Fault settings cannot be changed through the API. Fault analysis requires the
building of circuits with additional resistive elements and setting the elements to zero or
large values.

Enhancements to NI LabVIEW Instruments in NI Multisim

LabVIEW instruments in Multisim let you create custom input, output,
and input/output instruments for use in Multisim. Improvements in
Multisim 10.1 include support for both input and output pins on the same
instrument, continuous data out to Multisim from output instruments, and
the ability for input instruments to affect the time step and interpolation
method used in simulation.

NI Circuit Design Suite Release Notes 4 ni.com



Input and Output Instruments

Previous releases allowed input-only and output-only instruments.
Input/output instruments have all of the capabilities of input-only and
output-only instruments. Note, however, that LabVIEW instrument input
data is lagging (meaning that it arrives at the instrument in discrete chunks
after the simulator has produced the data), and streaming-out data is leading
(meaning that the simulator requests the data in discrete chunks before it
needs it). This means that tight feedback loops where a LabVIEW
instrument's output depends instantaneously on its intput are not possible.
In general, it will take at least one extra set of continuous outputs through
the “Update Data Get Output Values” event of the instrument before you
can be sure that the input received by that instrument reflects an adjusted
output signal.

Continuous Data from Output Instruments

Previously, data output instruments could generate a finite set of possibly
repeating data. When creating an output instrument that generates data
continously, remember that, in general, Multisim simulates circuits at arate
slower than the real-time behavior of an equivalent physical circuit.
Therefore, if you create an instrument that continuously acquires
real-world data using a data acquisition device, modular instrument,

or other similar hardware, and use that data as a simulation source in
Multisim, simulation will not be able to keep up with the acquired data
because it will be running at a rate slower than the data acquisition.

It is the responsibility of the output instrument creator to generate
sufficiently small chunks of data at a rate that allows Multisim simulation
to keep up with the data acquisition.

Affecting the Time Step and Interpolation Method

LabVIEW samples and processes data at even time steps. SPICE generally
operates at uneven time steps best suited to convergance and speed. When
creating an input instrument, it is neccesary to resample the data to evenly
spaced data for use in LabVIEW. You can now create an instrument that
uses Force Step interpolation. (Force Step is not strictly an interpolation
method. It forces the Multisim SPICE simulator to take additional
timesteps that line up with the requested sampling rate).

If a particular LabVIEW instrument allows you to set the sampling rate
and/or interpolation method, Multisim 10.1 recognizes changes to these
values during simulation.
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Increased Quality and Breadth of the Component Database

Multisim 10.1 includes new additions and improvements to the database.
These include around 300 new components from leading manufacturers,
more than 500 updated components, and the latest generic power
simulation parts.

New Components from Leading Manufacturers

There are around 300 new components with models from Analog Devices
and Texas Instruments. The additions include symbols, models, and IPC
compliant land patterns. These components include operational-amplifier,
comparator, analog switch, and voltage reference models.

Generic Power Simulation Parts

Multisim 10.1 includes models for all freely available power simulation
parts found in the latest release of “Switch-Mode Power Supplies Spice
Simulations and Practical Designs” by Christophe Basso. These
components include Buck, Boost, Buck-Boost, and PWM controllers.

Extended SPICE Modeling Capabilities

Multisim 10.1 introduces enhancements to its SPICE modeling
capabilities. The SPICE parser has been redesigned and improved to better
support multiple SPICE languages and advanced modeling. Multisim also
supports more Cadence® PSpice® parameters. There is also improved
XSPICE model error reporting.

Redesign and Improvement of the NI Multisim SPICE
parser

The SPICE parser in Multisim interprets the native SPICE net lists, reports
syntax errors, and evaluates mathematical expressions. Enhancements to
the parser include:

e Improved syntax and simulation compatibility for controlled sources.
*  Table sources.

e Numerous compatibility improvements that enhance the ability to
support Cadence® PSpice® and Intusoft IsSpice4™ syntax.

¢ Flexible component, net, terminal, and model names.

— Names may contain any characters with the exception of white
space and the following characters: * ' () { } [ ], # $: ;

*  The ability to use expressions in place of any value in the netlist.

—  The two special exceptions to this are the BSIM level param and
the POLY number in a controlled source.
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*  Improved support for expressions, including:

— Support of inline if statements.

— Improved support for . param statements.

—  Full support of single and nested . func statements.

—  Current through diodes and relevant controlled sources can now
be used in expressions (for arbitrary sources).

— Improved convergence for complex behavioral-modeling style

circuits.

Improved SPICE Model Error Reporting

More intelligent error messages are presented for errors relating to SPICE

models.

Component terminals, parameters and expressions are now checked in
depth before the simulation begins. Simulation errors display in the
Simulation tab of the Spreadsheet View and identify the Multisim
components that are causing the issue.

@ Note With the exception of the Simulation tab and the Results tab, the Spreadsheet View
is not available in the Base or Full editions of Multisim. Refer to the Multisim help file for

information about these tabs.

Improvements to Cadence® PSpice® Compatibility

Multisim 10.1 now supports the following Cadence® PSpice® parameters

for MOSFETS and BJTs:

Parameter Description Device

m Device multiplicity parameter MOSFET

Rg, Rb Gate and Bulk Ohmic Resistance MOSFET

Rds Drain-Source Shunt Resistance MOSFET

W, L Width and Length support on MOSFET

.model line
Nk Knee current roll-off coefficient BJT
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NI Update Service

The new NI Update Service helps keep your National Instruments software
and drivers up-to-date. NI Update Service, which replaces the existing
Support and Upgrade Utility (SUU), checks for and electronically delivers
software updates for your NI software. You can launch NI Update Service
at any time to check for updates or determine the most recent time updates
were installed.

Windows Vista Compliant

NI Circuit Design 10.1 is Windows Compliant. Version 10.0.1 was Vista
compatible but continued to write to the Program Files directory during
run-time. Multisim 10.1 follows Vista Compliance Guidelines.

Better Storage of User Fields from the Master
Database

User fields associated with components stored in the Master database are
now stored separately. You will see no visible impact when editing and
working with user fields in Multisim. This will, however, help to preserve
data as you migrate from version to version. This is also required for Vista
compliance.

Support of TDMS Data Files

Multisim now supports TDMS files. TDM voltage and current sources can
reference TDM streaming data files and the Multisim Grapher can export
TDMS data.

Files are Compatible with NI Circuit Design Suite 10.0.x

Files from NI Circuit Design Suite 10.0.x and 10.1 are backward and
forward compatible. File extensions remain the same; files saved with
either version will open in both versions.

New Font Rendering in NI Ultiboard

Fonts placed on layers on the board in Ultiboard are now drawn using
anti-grain geometry. This provides faster font rendering and better
anti-aliasing.
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Localization

NI Circuit Design Suite 10.1 is localized for English, German, and
Japanese. The system locale setting determines the default language used
by the software.

To change the default language the software uses, select Options»Global
Preferences, click on the General tab, select the desired locale from the
Language combination box, and restart the application.

The following items are not localized, and remain in English:
e LabVIEW instruments.

* Layer names in both NI Ultiboard and the NI Multisim
Spreadsheet View.

* Agilent and Tektronix simulated instruments.
*  Sample files.

*  MCU functionality: source file names, code/comments within source
files, and compiler/linker messages.

The following documentation is available in English, German, and
Japanese:

¢ Release Notes.

*  Getting Started with NI Circuit Design Suite.

User manuals and help files are not localized, and remain in English.

Product Tier Details

The following lists the schematic capture functionality available in
Multisim Base, Full, and Power Pro editions:

Functionality Base Full Power Pro
Customizable GUI X X X
Modeless part placement X X X
and wiring
Fast retrieval parts bins X X X
User defined fields X X X
Advanced symbol editor X X X
Auto and manual wiring X X X
Virtual wiring by X X X
node name
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Functionality Base Full Power Pro
Fast auto-connect passives X X X
Rubber banding on part X X X
move
Replace multiple X X X
components at once
Bus-Vector connect X X X
Project manager X X X
Hierarchical design X X X
Multisheet design X X X
Circuit annotations X X X
Comments on schematic X X X
Electrical rules check X X X
Title block editor X X X
Forward/Back annotation X X X
Export to Mentor PADS X X X
layout
Advanced search X X X
Variant support X
Spreadsheet view X
Design constraints X
Zoom to selected part X
Pin and gate swap X
Customizable BOM X
Advanced reports X
Cross-probing with X
Ultiboard
ERC scope setting X
Mark no-connect pins X
Database import/export X
Component database Partial Partial Complete
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The following lists the simulation functionality available in Multisim Base,
Full, and Power Pro editions:

Functionality Base Full Power Pro
Interactive simulator X X X
Fully mixed-mode X X X
A/D simulation
Standard X X X
SPICE 3X5/XSPICE
Enhanced model X X X
support
Cadence® PSpice® X X X
model simulation®
Speed/Accuracy X X X
tradeoffs
Simulation Advisor X X X
Convergence Assistant X X X
Virtual, interactive, X X X

animated parts

Mouse click support for X X X
interactive parts

Measurement Probes X X X
Component Wizard X X X
NI measurement data X X X

file sources

NI measurement data X X X
file export

NI LabVIEW VIs as X X
instruments and sources

Simulation Profiles X X
Postprocessor X X
Expressions in analyses X X
Add traces to Grapher X X

post analyses
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Functionality Base Full Power Pro
Rated components X X
Insert faults into X X
components
Op-Amp Wizard X
555 Timer Wizard X
Filter Wizard X
CE Amplifier Wizard X
Model makers X
Switch mode power X
supply generics
RF Design Module X
Nested sweeps X
C-Code modeling X
Virtual Instruments 4 15 22
Analyses 0 15 19
Simulated Agilent 0 1 3
Instruments
Simulated Tektronix 0 0 1
instrument
Multisim MCU X X
Multisim Automation X
API
* Does not support all Cadence® PSpice® syntax
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The following lists the layout functionality available in Ultiboard Full and
Power Pro editions:

Functionality Full Power Pro

Gridless Follow-me placement X X
Push and Shove part placement X X
Push and Shove trace placement X X
Real-time & from copper ratsnest X X
Auto-alignment X X
Real-time polygon update with voiding X X
Keep-in/Keep-out areas X X
Forward/Backward annotation X X
Real-time DRC X X
Jump to Error X X
64 layers and 1 nanometer resolution X X
Polar Grids X X
Customizable layer viewing X X
Split power-planes X X
Comprehensive Footprint Wizard X X
Enhanced 3D visualization with print X X
Full screen mode X X
Gerber, DXF, IPC-D-356A, X X
SVG output

Dimensions on PCB and Landpatterns X X
Dimensions in Database Manager X X
User annotations X X
Net bridges X X
3D visualization inside circuit board X
Turn off ratsnest for selected nets X
Load and save technology files X
Cross-probing with Multisim X
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Functionality Full Power Pro

Variant Support X

Component Placement Sequencer

Place components in array

Unplace all components

R I e e

Ruler bar alignments and
measurements

Save PCB Design as a component

Permanent grouping

Pin & gate swapping

Gridless Connection Machine

High-speed constraint driven layout

Multiple clearances

Net topology choices

Equispace trace support

Differential Impedance Calculator

Transmission Line Calculator

Microvias

Test point insertion

Automatic tear-dropping

Pin necked trace support

Automatic jumper insertion

Copy Route & Replica Place functions

In-place footprint editor

Mechanical CAD

T I I B e ol T e ol e Bl ol e B B o B I B e

Export 3D info in 3D IGES,
DXF formats

o

Copper amount report

Test point report X

Number of pins supported 1,400 Unlimited

Spreadsheet view Limited Complete
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The following lists the autorouting functionality available in Ultiboard Full
and Power Pro editions:

Functionality Full Power Pro
Autoplacement X X
Pin & gate swapping X X
Fully customizable cost factors X X
Progressive Routing X X
Interactive autorouting X X
Constraint driven routing X X
Follows keep-in/keep-out criteria X X
Manual pre-placement: components, X X
vias, traces
Auto Block Capacitor recognition X X
SMD mirroring X X
Net shielding X X
Automatic testpoint insertion X X
Trace rubberbanding X X
Topology: shortest, daisy chain, star X
Prioritize routing order X
Route an individual net X
Automatic bus routing X
Differential Pair routing X
Group autoplace X
Group autoroute X
Optimization X
Pin number limit 1,400 Unlimited
Maximum number of layers 4 64
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Documentation

NI Circuit Design Suite 10.1 includes a complete documentation set
featuring printed and electronic resources for your reference.

The following printed and electronic resources are available:
e Getting Started with NI Circuit Design Suite Manual
e NI Circuit Design Suite Release Notes

The following electronic resources are available in PDF files:
*  Multisim User Manual
»  Ultiboard User Manual

E Note Because the NI Multisim MCU Module functionality is now included with
NI Multisim, the Multisim MCU Module User Guide has been discontinued. Refer to the
Multisim User Manual for information about Multisim MCU. The Multisim Component
Reference Guide has been discontinued. Refer to the Component Reference Help File for
information about components.

To access the user manuals, select Start»All Programs»National
Instruments»Circuit Design Suite 10.1»Documentation and then select
the file of interest.

The following online help files are available from the installed software
Help menu and from the Start menu:

*  Multisim Professional Edition Help File
e Ultiboard Help File

To access the Help Files, from the Start menu, select Start»
All Programs»National Instruments»Circuit Design Suite 10.1»
Documentation and then select the file of interest.

The following online help files are available from the installed software
Help menu:

e Component Reference Professional Edition Help File
e Multisim Symbol Editor Help File (access from the Symbol Editor)

*  Multisim Title Block Editor Help File (access from the Title Block
Editor)

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location:
Help»Patents in your software, the patents. txt file on your CD, or ni . com/patents.

© 2007-2008 National Instruments Corporation. All rights reserved. 374478C May08
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VERSIONSHINWEISE ZUR PROFESSIONAL EDITION

NI Circuit Design Suite

Version 10.1

In der vorliegenden Broschiire werden die Systemvoraussetzungen zur
Installation der NI Circuit Design Suite 10.1 beschrieben und Sie finden
Informationen zu den einzelnen Produktversionen und allen Neuerungen
seit NI Multisim 10.0.1 und NI Ultiboard 10.0.1.

Die NI Circuit Design Suite umfasst die bekannten Anwendungen

NI Multisim und NI Ultiboard der National Instruments Electronics Work-
bench Group. Das Multisim-MCU-Modul ist nun in NI Multisim enthalten.
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Installation der NI Circuit Design Suite 10.1

Nachfolgend werden die Systemvoraussetzungen und Hinweise zur Instal-
lation der NI Circuit Design Suite beschrieben.

Mindestvoraussetzungen zur Installation

Um die NI Circuit Design Suite 10.1 problemlos ausfiihren zu koénnen,
sollte Thr System die folgenden Voraussetzungen erfiillen:

Installationsanleitung

Windows 2000 mit mindestens Service Pack 3, Windows XP,
Vista oder 64-Bit-Vista.

Pentium-4- oder gleichwertiger Mikroprozessor (mindestens
Pentium 3).

512 MB Arbeitsspeicher (mindestens 256 MB).

1,5 GB freie Festplattenkapazitit (mindestens 1 GB).

Open-GL®-fihige 3D-Grafikkarte (Videoadapter mit SVGA-Aufls-
sung mit einer Videoauflosung von mindestens 800 x 600 —empfohlen
werden jedoch mindestens 1024 x 768).

Zum Erstellen eigener virtueller LabVIEW-Instrumente fiir Multisim
ist LabVIEW 8.2.x oder 8.5.x erforderlich.

Mit dem Installationsprogramm der NI Circuit Design Suite 10.1 werden
NI Multisim und NI Ultiboard installiert.

Es wird empfohlen, vor Installation der NI Circuit Design Suite alle gedft-
neten Anwendungen zu schliefen.

Versionshinweise zur NI Circuit Design Suite 2 ni.com



Sofern Sie kein anderes Installationsverzeichnis angeben, wird die
NI Circuit Design Suite in das Verzeichnis <Programme>\National
Instruments\Circuit Design Suite 10.1 installiert.

1.

Produktaktivierung

Legen Sie die CD mit der NI Circuit Design Suite in das
CD-ROM-Laufwerk ein. Wenn das Installationsprogramm nicht auto-
matisch startet, klicken Sie im Start-Menii von Windows auf
Ausfiihren und starten Sie die Datei setup . exe auf der CD.

Folgen Sie den Anweisungen auf dem Bildschirm.

Bei erstmaliger Ausfiihrung eines Programms der NI Circuit Design Suite
werden Sie zur Lizenzaktivierung fiir das betreffende Programm
aufgefordert.

Wenn Sie keine giiltige Lizenz aktivieren, lduft das Programm im Evaluie-
rungsmodus und Sie werden bei jedem Start des Programms nach einer
Lizenz gefragt. Der Evaluierungszeitraum betrégt 30 Tage.

Informationen zur Aktivierung des Programms erhalten Sie in der Aktivie-
rungsanleitung fiir Software von National Instruments, die der NI Circuit
Design Suite 10.1 beiliegt.

Neue Funktionen der NI Circuit Design Suite 10.1

Die NI Circuit Design Suite 10.1 wartet mit folgenden neuen Programm-
funktionen bzw. Verbesserungen auf:

© National Instruments Corporation

Neue ActiveX-API in Multisim

Verbesserungen von LabVIEW-Instrumenten in Multisim
Erweiterte Bauelemente-Datenbank

Verbesserte SPICE-Simulation

NI Update Service

Vista-Tauglichkeit

Unterstiitzung von TDMS-Dateien

Dateikompatibilitit mit der NI Circuit Design Suite 10.0.x
Neue Schriftartdarstellung bei NI Ultiboard
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ActiveX-API in NI Multisim

Die ActiveX-API in NI Multisim ermoglicht eine automatisierte Simula-
tion und Analyse iiber eine COM-Schnittstelle. Dies ist dann sinnvoll,
wenn mehrere Simulationsldufe mit unterschiedlichen Schaltungen erfor-
derlich sind, wie z. B. bei der Bauelement-, Belastungs- oder
Fehleranalyse.

Die ActiveX-API ermoglicht die programmatische Steuerung einer
Multisim-Simulation, ohne dass dazu eine Multisim-Ansicht zwingend
notwendig wire. Clients, die mit einer COM-fahigen Programmiersprache
wie NI LabVIEW, Visual Basic oder C++ erstellt wurden, konnen iiber
diese Schnittstelle auf Multisim zugreifen.

Mittels der API konnen Sie:
*  Eine vorhandene Schaltung 6ffnen und schliefen

* Anstelle einer bestehenden Spannungs- oder Stromquelle ein Signal
einspeisen

¢ Simulationen starten/stoppen/unterbrechen

* Simulationsergebnisse eines statischen Tastkopfs abfragen

* Die einzelnen Bauelemente in der Schaltung benennen

e  Bauelemente durch solche aus der Datenbank ersetzen

e Werte fiir Widerstéinde, Kondensatoren und Spulen abfragen
e Varianten durchnummerieren

¢ Die aktive Variante abfragen und fiir Simulationen auswihlen

e Schaltungsberichte einschlieBlich Stiickliste und Netzlistenbericht
erstellen

*  Eine Abbildung der Schaltung erstellen.

E Hinweis Die Simulationseinstellungen wéihrend API-gesteuerter Simulationen stammen
von den Einstellungen der Transientenanalyse der ausgewéhlten Schaltung. Anderungen
an den interaktiven Simulationseinstellungen bleiben unberiicksichtigt.

Die API-Funktion kann nur Bauelemente auf der oberen Ebene eines Entwurfs verdndern
und ersetzen; Bauelemente in Teilschaltungen und hierarchischen Schaltungsblocken
konnen nicht modifiziert werden.

Multisim-Austauschbauelemente fiihren unter Umstidnden nicht immer zum gewiinschten

Ergebnis — diese sollten deshalb stets in einer interaktiven Multisimsitzung getestet wer-
den, um sicherzustellen, dass das Verhalten den Erwartungen entspricht.

Versionshinweise zur NI Circuit Design Suite 4 ni.com



Fehlerhafte Multisim-Einstellungen konnen nicht iiber die API-Funktion verandert wer-
den. Die Fehleranalyse erfordert die Erstellung von Schaltungen mit zusétzlichen
Widerstandselementen, und dass die Elemente auf Null oder auf grole Werte gesetzt
werden.

Verbesserungen von NI LabVIEW-Instrumenten in NI Multisim

Mit Hilfe von LabVIEW konnen Sie Instrumente zur Eingabe und/oder
Ausgabe nach eigenen Vorstellungen erstellen und in Multisim einbinden.
Zu den Verbesserungen in Multisim 10.1 gehoren die Unterstiitzung von
Eingabe- und Ausgabe-Anschlussstiften am selben Instrument, die fortlau-
fende Dateniibertragung an Multisim von Ausgabeinstrumenten, sowie die
Fihigkeit, mit Hilfe von Eingabeinstrumenten auf die in der Simulation
verwendeten Zeitschritt- und Interpolationsverfahren Einfluss zu nehmen.

Eingabe- und Ausgabeinstrumente

In friiheren Versionen konnten entweder nur Ein- oder nur Ausgabeinstru-
mente genutzt werden. Nun konnen Instrumente mit zwei Datenrichtungen
genutzt werden, ohne dass diese den bisherigen im Funktionsumfang nach-
stehen. Beachten Sie jedoch, dass bei der Erfassung die Daten erst vom
Simulator erzeugt und dann paketweise an LabVIEW-Instrumente {ibertra-
gen werden. Analog werden Ausgangsdaten zunichst vom Simulator
angefordert, bevor das Instrument paketweise mit der Ubertragung beginnt.
Aufgrund dieser Verzogerung kénnen keine Riickkopplungsschleifen
erzeugt

werden, bei denen die Ausgangswerte sofort wieder am Eingang zur
Verfiigung stehen miissen. Meist bendtigt das Instrument mindestens eine
zusitzliche Iteration des Ereignisses “Update Data Get Output Values”,
bevor am Eingang des Instruments mit Sicherheit der neueste Ausgangs-
wert anliegt.

Fortlaufende Daten von Ausgabeinstrumenten

Bisher war es so, dass Ausgabeinstrumente nur eine bestimmte Menge an
Daten (ggf. wiederholt) erzeugen konnten. Bei der Erstellung eines Ausga-
beinstruments, das Daten fortlaufend generiert, muss stets bedacht werden,
dass Multisim Schaltungen im Allgemeinen langsamer simuliert als eine
reale Schaltung. Falls Sie also ein Instrument erstellen, dass kontinuierlich
reale Daten mit Hilfe einer Datenerfassungsvorrichtung, einem modularen
Instrument oder dhnlicher Hardware erfasst, um diese Daten als Simulati-
onsquelle in Multisim zu verwenden, so ist die Simulation nicht in der
Lage, mit den erfassten Daten Schritt zu halten, da die Simulation langsa-
mer abliuft als die Datenerfassung.
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Es obliegt also dem Entwickler des Ausgabeinstruments, die Datenpakete
entsprechend klein zu halten und in einer Geschwindigkeit zu iibertragen,
bei der die Multisim-Simulation mit dem Tempo der Datenerfassung
Schritt halten kann.

Einflussnahme auf das Zeitschritt- und
Interpolationsverfahren

LabVIEW erfasst und verarbeitet Daten in gleichméBigen Zeitschritten.
SPICE arbeitet im Allgemeinen in ungleichmifigen Zeitschritten, die der
Konvergenz und der Geschwindigkeit gut angepasst sind. Bei der Erstel-
lung eines Eingabeinstruments ist es notwendig, die Daten vor der
Verwendung in LabVIEW erneut abzutasten, um gleichméBig angeordnete
Daten zu erhalten. Jetzt konnen Sie auch Instrumente erstellen, die von der
Force-Step-Interpolationsfunktion Gebrauch machen. (Force Step ist
streng genommen kein Interpolationsverfahren. Es zwingt den Multisim-
SPICE-Simulator zu zusitzlichen Zeitschritten, die sich in die vorgesehene
Abtastfrequenz eingliedern.)

Falls ein bestimmtes LabVIEW-Instrument die Einstellung der Abtastfre-
quenz und/oder des Interpolationsverfahren ermoglicht, erkennt
Multisim 10.1 wihrend der Simulation auftretende Verinderungen dieser
Werte.

Verbesserte und umfangreichere Bauelemente-Datenbank

An der Bauelemente-Datenbank von Multisim 10.1 wurden zahlreiche
Ergidnzungen und Verbesserungen vorgenommen. Dazu gehoren etwa 300
neue Bauelemente fiihrender Hersteller, mehr als 500 aktualisierte Bauele-
mente sowie generische Bauteile zur Simulation von Stromversorgungen
neuester Generation.

Neue Bauelemente fithrender Hersteller

Etwa 300 neue Bauelemente mit Modellen der Unternehmen Analog
Devices und Texas Instruments sind verfiigbar. Dazu gehoren entspre-
chende Symbole, Modelle und Land-Pattern nach IPC-Standard. Zu den
Bauelementen gehoren Operationsverstirker, Komparatoren, Analogschal-
ter und Vergleichsspannungsquellen.
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Generische Bauteile zur Simulation von
Stromversorgungen

Multisim 10.1 enthilt Modelle fiir alle frei verfiigbaren Bauteile zur Simu-
lation von Stromversorgungen, die aus der zuletzt erschienenen Ausgabe
der Switch-Mode Power Supply SPICE Simulations and Practical Designs
von Christophe Basso hervorgehen. Zu diesen Bauelementen gehoren Auf-
warts-, Abwirts-, Aufwirts-/Abwiirts sowie PWM-Steuerelemente.

Erweiterte Fahigkeiten zur SPICE-Modellierung

Bei Multisim 10.1 gibt es auBerdem Verbesserungen an der SPICE-Model-
lierungsfunktion. Der SPICE-Parser wurde umgestaltet und verbessert, um
mehrere SPICE-Sprachen und die erweiterte Modellierung besser unter-
stiitzen zu kénnen. Multisim unterstiitzt nun auch weitere Cadence®-
PSpice®-Parameter. Auch die XSPICE-Modell-Fehlermeldung wurde
verbessert.

Neugestaltung und Verbesserung des NI Multisim
SPICE-Parser

Der SPICE-Parser in Multisim interpretiert die nativen SPICE-Netzlisten,
meldet Syntaxfehler und bewertet mathematische Ausdriicke. Zu den Ver-
besserungen des Parsers gehoren:

*  Verbesserte Syntax und Simulationskompatibilitit fiir geregelte
Quellen.

e Quelltabellen.

*  Eine Vielzahl an Kompatibilititsverbesserungen erweitern die Féhig-
keit zur Unterstiitzung der Cadence®-PSpice®- und Intusoft
IsSpice4™-Syntax.

*  Flexible Bezeichnungen fiir Bauelemente, Netze, Anschliisse und

Modelle.

— Die Bezeichnungen konnen beliebige Zeichen enthalten, mit Aus-
nahme von Leerstellen und den folgenden: * ' () { } [ 1 ,
# S:

» Die Moglichkeit, Ausdriicke anstelle beliebiger Werte in der Netzliste
zu verwenden.

—  Zwei spezielle Ausnahmen bilden hierbei der BSIM-Ebe-
nen-Parameter und die POLY-Nummer in einer geregelten Quelle.

*  Verbesserte Unterstiitzung fiir Ausdriicke, einschlieBlich:
—  Unterstiitzung von Inline-1i £-Befehlen.

—  Verbesserte Unterstiitzung fiir . param-Befehle.
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—  Volle Unterstiitzung von einzelnen und verschachtelten
. func-Befehlen.

—  Strom, der durch Dioden und relevante geregelte Quellen flief3t,
kann nun in Ausdriicken (fiir nicht eindeutige Quellen) verwendet
werden.

—  Verbesserte Fihigkeit zum Ermitteln einer stabilen Losung fiir
komplexe Verhaltenssimulationsschaltungen.

Verbesserte SPICE-Modell-Fehlermeldung

Fehlermeldungen, die sich auf SPICE-Modelle beziehen, sind nun aussage-
kraftiger als zuvor.

Bauelementanschliisse, Parameter und Ausdriicke werden nun eingehend
iiberpriift, bevor die Simulation beginnt. Simulationsfehler werden auf der
Registerkarte “Simulation” in der Tabellen-Ansicht angezeigt und identifi-
zieren genau die Multisim-Bauelemente, welche die Probleme
verursachen.

@ Hinweis Mit Ausnahme der Registerkarten “Simulation” und “Ergebnisse” ist die Tabel-
len-Ansicht in der Basis- oder Vollversion von Multisim nicht verfiigbar. Um weitere
Informationen zu diesen Registerkarten zu erhalten, sehen Sie sich bitte die Multisim-
Hilfedatei an.

Verbesserungen der
Cadence®-PSpice®-Kompatibilitat

Multisim 10.1 unterstiitzt ab sofort die folgenden Cadence®-PSpice®-Para-
meter fiir MOSFETS und BJTs:

Parameter Beschreibung Bauteil
m Gerite-Mehrfachparameter MOSFET
Rg, Rb Gatter- und Substratwiderstand MOSFET

(Ohmscher Widerstand)
Rds Drain-Source MOSFET

Nebenschlusswiderstand

W, L Unterstiitzung von Breite (W) und | MOSFET
Linge (L) an Zeile .model

Nk Kniestrom Roll-off-Koeffizient BIJT
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NI Update Service

Der NI Update Service hilft Thnen dabei, Ihre Software von National
Instruments und die dazugehorigen Treiber auf dem neuesten Stand zu hal-
ten. Der NI Update Service ersetzt das Support and Upgrade Utility (SUU),
fiihrt eine Suche nach Updates fiir [hre Software von National Instruments
durch und 14dt diese herunter. Mit dem Programm koénnen Sie jederzeit
feststellen, ob Sie mit der neuesten Version Ihrer Software arbeiten.

Windows-Vista-Tauglichkeit

NI Circuit Design 10.1 ist fiir Windows geeignet. Die Version 10.0.1 war

bereits fiir Vista geeignet, hat jedoch wihrend der Laufzeit Eintrdge in das

Programmdateiverzeichnis vorgenommen. Multisim 10.1 erfiillt die Richt-
linien zur Vista-Kompatibilitit.

Bessere Speicherung benutzerspezifischer Felder
aus der Hauptdatenbank

Benutzerspezifische Felder, die mit in der Hauptdatenbank gespeicherten
Bauelementen zusammenhingen, werden nun separat abgelegt. Bei der
Arbeit bzw. Bearbeitung mit/von benutzerspezifischen Feldern in Multisim
werden Sie keinen sichtbaren Unterschied feststellen konnen. Auf diese
Weise bleiben jedoch die Daten von Version zu Version erhalten. Dies ist
auch eine Voraussetzung fiir Vista-Kompatibilitét.

Unterstiitzung von TDMS-Dateien

Multisim unterstiitzt nun TDMS-Dateien. TDM-Spannungs- und Strom-
quellen konnen auf TDM-Streaming-Dateien verweisen und das
Multisim-Diagrammfenster ist in der Lage, TDMS-Daten zu exportieren.

Dateikompatibilitat mit NI Circuit Design Suite 10.0.x

Dateien der NI Circuit Design Suite 10.0.x und 10.1 sind riickwirts- und
vorwirtskompatibel. Dateierweiterungen bleiben unverindert; Dateien
lassen sich mit beiden Versionen 6ffnen, egal mit welcher Version sie
abgespeichert wurden.

Neue Schriftartdarstellung in NI Ultiboard

Schriftarten auf Leiterplattenlagen in Ultiboard werden nun mit Hilfe der
Anti-Grain-Geometry abgebildet. Dadurch werden Schriftarten schneller
dargestellt und auch die Kantenglittung (Antialiasing) wird verbessert.
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Lokalisierte Versionen

Die NI Circuit Design Suite 10.1 gibt es in iibersetzter Fassung auf
Deutsch, Englisch und Japanisch. Je nach Regionaleinstellung verwendet
die Software die voreingestellte Sprache.

Zum Andern der Sprache des Programms wiihlen Sie Optionen»Allge-
meine Einstellungen, klicken auf die Registerkarte Allgemein, wéhlen die
gewiinschte Sprache aus dem Feld Spracheinstellungen aus und starten
die Anwendung neu.

Die folgenden Programmkomponenten liegen nur auf Englisch vor:
*  LabVIEW-Instrumente.

* Lagennamen in der Spreadsheet-Ansicht von NI Ultiboard und
NI Multisim.

e Simulierte Messgerite von Agilent und Tektronix.
e Beispieldateien.
¢ MCU-Funktionen: Namen von Quelldateien, Code/Kommentare in

Quelldateien und Compiler-/Linker-Meldungen.

Die folgende Dokumentation ist auch auf Englisch, Deutsch und Japanisch

erhiltlich:

e Versionshinweise.

*  Erste Schritte mit der NI Circuit Design Suite.

Benutzerhandbiicher und Hilfedateien liegen nur auf Englisch vor.

Einzelheiten zu dieser Version

Im Folgenden finden Sie eine Ubersicht iiber die Funktionen zur Erstellung

von Schaltplidnen in Multisim Base, Full und Power Pro:

Funktion Basisversion Vollversion Power Pro

Konfigurierbare Bedienoberfliche X X X
Bauteilplatzierung und -verdrahtung mit X X X
automatischer Modusumschaltung

Schneller Zugriff auf Bauelemente in X X X

den Werkzeugleisten

Benutzerdefinierte Felder X X X
Erweiterter Symboleditor X X X
Automatische und manuelle Verdrahtung X X X
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Funktion Basisversion Vollversion Power Pro

Virtuelle Verdrahtung per Knotennamen X X X

Schnelle automatische Verbindung X X X
passiver Bauelemente

Automatische Verbindungsanpassung X X X
beim Verschieben von Bauelementen

>~
>~
>

Gleichzeitiges Ersetzen mehrerer
Bauelemente

Bus-Vektorverbindungen

Projektmanager

Hierarchische Schaltungsentwicklung

MR XA
XXX X
M| XXX

Schaltungen auf mehreren
Arbeitsblittern

>
o
o

Notizen zum Schaltplan

>
o
o

Kommentarfelder im Schaltplan

Priifung auf Einhaltung der elektrischen X X X
Schaltungsregeln

Titelblockeditor X X

=

=

Weitergabe von Schaltplan- und X X
Bauteilnotizen

Export als Mentor-PADS-Layout X X

Erweiterte Suche X X

Versionsunterstiitzung

XXX X

Ansicht als
Tabellenkalkulationsdokument

Entwurfseinschrinkungen

Markierten Bereich heranzoomen

Tausch von Anschlussstift und Gatter

Frei konfigurierbare Stiickliste

Erweiterte Berichte

Tl Il B el o

Gleichzeitige Hervorhebung in
Schaltplan und Layout mit Ultiboard

o

ERC-Oszillographeneinstellung
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Funktion Basisversion Vollversion Power Pro
Markierung freier Anschlussstifte X
Datenbankimport und -export X
Bauelemente-Datenbank Teilweise Teilweise Vollstindig

Im Folgenden werden die Simulationsfunktionen in Multisim Base,
Full und Power Pro aufgefiihrt:

Funktion Basisversion Vollversion Power Pro

Interaktiver Simulator X X X

Kombinierte Simulation analoger und X X X

digitaler Bauelemente

StandardmiBiges SPICE 3X5/XSPICE X X X

Erweiterte Modellunterstiitzung X X X

Cadence®-PSpice®-Modellsimulation™ X X X

Einstellen von Geschwindigkeit und X X X

Genauigkeit

Simulation Advisor X X X

Assistent zur automatischen Korrektur X X X

von SPICE-Simulationsfehlern

Virtuelle, interaktive und animierte X X X

Bauelemente

Bedienung von Bauelementen per X X X

Mausklick

Mess-Tastkopfe X X X

Bauelement-Assistent X X X

Arbeit mit National-Instruments- X X X

Dateiformaten fiir Messwerte

Export in National-Instruments- X X X

Dateiformate fiir Messwerte

NI-LabVIEW-VIs als Messgerite und X X

Quellen

Simulationsprofile X X

Postprozessor X X
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Funktion Basisversion Vollversion Power Pro
Nutzung von Ausdriicken in Analysen X X
Hinzufiigen von Kurven zum Diagramm X X
nach Analysen
Bauelemente mit bestimmbarer X X
Hochstbelastung
Einbauen von Fehlern in Bauelemente X X
Op-Verst.-Assistent X
555-Timer-Assistent X
Filterassistent X
CE-Verstirker-Assistent X
Modellgeneratoren X
Generische Schaltnetzteile X
RF-Design-Modul X
Linear variable X
Verschachtelungsparameter
Modellierung in C X
Virtuelle Messinstrumente 4 15 22
Analysen 0 15 19
Simulierte Instrumente von Agilent 0 1 3
Simuliertes Tektronix-Instrument 0 0 1
Multisim-MCU X X
ActiveX-API in Multisim X

* Unterstiitzt nicht jede Cadence®-PSpice®-Syntax

Im Folgenden werden alle Layout-Funktionen in Ultiboard Full und Power
Pro aufgezihlt:

Funktion Vollversion Power Pro

Rasterlose Follow-me-Leiterbahnverlegung X X

Bauteilplatzierung durch “Push & Shove”

X X
Leiterbahnplatzierung durch “Push & Shove” X X
X X

Echtzeitfunktionen und Funktion “From Copper Ratsnest”
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Funktion

Vollversion

Power Pro

Automatisches Ausrichten

X

X

Laufende Anpassung von Polygonen mit Anordnung
kupferloser Flichen

o

e

Freizuhaltende Platinenbereiche

Weitergabe von Schaltplan- und Bauteilnotizen

Laufendes Priifen auf Einhaltung der Entwurfsregeln

Springen zu fehlerhaften Stellen

64 Lagen und Auflosung von 1 nm

Polarnetze

Kundenspezifische Lagenansicht

Aufgeteilte Speisungsschichten

Leistungsfahiger Footprint-Assistent

Erweiterte 3D-Visualisierung mit Druckfunktion

Vollbildschirmdarstellung

Ausgabe der Daten im Gerber-, DXF-, IPC-D-356A- und
SVG-Format

AR AR R A R R R e R e R e R R A R A R A R

T I o B Bl ol (e el ol (e el ol (e

Abmessungen von Leiterplatte und Footprint

Abmessungen im Datenbank-Manager

Anwenderkommentare

Netzankniipfungspunkte

XXX X

3D-Visualisierung innerhalb der Leiterplatte

Ausschalten der Ratsnest-Funktion fiir ausgewéhlte Netze

Laden und Speichern von Technologiedateien

Gleichzeitige Hervorhebung in Schaltplan und Layout mit
Multisim

o T T Tl Bl Bl e el

Versionsunterstiitzung

e

Automatisches Einfligen von Bauelementen in vorgegebener
Folge

e

Gruppenweise Platzierung von Bauelementen

Entfernen aller platzierten Bauelemente
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Funktion Vollversion Power Pro

Linealausrichtung und -messungen X

Speichern von Platinenentwiirfen als Bauelement

Dauerhafte Gruppierung

Austauschen von Anschlussstiften und Gattern

Rasterlose Leiterbahnsuche

XXX XX

Hochgeschwindigkeitsentwicklung von Leiterplattenlayouts
nach Entwurfsregeln

Multiple Freirdume

Auswahl der Netztopologie

Leiterbahnplatzierung mit einheitlichem Abstand

Rechner fiir differentielle Impedanz

Rechner fiir Ubertragungsleitung

Mikrovias

Einfiigen von Testpunkten

UL R R XX X )| ™

Automatisches Generieren trainenférmiger Verstarkungen
zwischen Lotaugen und Leiterbahnen

>~

Unterstiitzung von Leiterbahnen mit abgeknickten Segmenten
zu Anschlussstiften

Automatisches Einsetzen von Steckbriicken

Funktionen “Route kopieren” und “Platzierung wiederholen”

Footprints auf Platine editierbar

CAD-Funktionen zur Entwicklung mechanischer Elemente

Export von 3D-Info in 3D IGES, DXF-Formate

R X X X X X

Berechnung des Kupferbedarfs

Testpunktbericht X

Mobgliche Anzahl von Anschlussstiften 1400 Unbegrenzt

Ansicht als Tabellenkalkulationsdokument Begrenzt Vollstindig
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Im Folgenden werden die Funktionen zur automatischen Leitungsfiihrung
in Ultiboard Full und Power Pro aufgezéhlt:

Funktion

Vollversion

Power Pro

Automatisches Platzieren

X

X

Austauschen von Anschlussstiften und Gattern

Voll konfigurierbare Kostenberechnung

Progressive Leiterbahnfiihrung

Interaktive automatische Leiterbahnfiihrung

Leiterbahnfiihrung unter Beriicksichtigung von
Entwurfsregeln

ol B Bl Il e

ol B Bl Il

Folgt den Kriterien der belegbaren/freizuhaltenden Bereiche

>~

>

Manuelles Vorplatzieren: Bauelemente,
Durchkontaktierungen, Leiterbahnen

>~

>

Automatische Erkennung von Blockkondensatoren

Spiegeln von oberflichenmontierbaren Bauelementen

Abschirmen von Netzen

Automatisches Einsetzen von Testpunkten

“Gummiband”-Leiterbahnen

| P X | X

Topologie: kiirzestmogliche Leiterbahnlinge, sternformige
Leiterbahnfiihrung und Verkettung der Leiterbahnen

RUp | X | ) X

Priorisierung der Leiterbahnfiihrungsreihenfolge

Leiterbahnfiihrung eines einzelnen Netzes

Automatische Leiterbahnfiihrung fiir Busse

Automatische Leiterbahnfiihrung symmetrischer
Leitungspaare

X R XX

Automatisches Platzieren von Gruppen

X

Automatische Leiterbahnfiihrung von Gruppen

X

Automatische Optimierung des Leiterplattenlayouts

X

Maximale Anzahl von Anschlussstiften

1400

Unbegrenzt

Maximale Anzahl von Lagen

64
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Dokumentation

Zur NI Circuit Design Suite 10.1 gehort eine umfassende Dokumentation.

Die folgenden Dokumente sind in gedruckter und in elektronischer Form
verfiigbar:

*  Handbuch Erste Schritte mit der NI Circuit Design Suite

»  Versionshinweise zur NI Circuit Design Suite

Die folgenden Dokumente liegen elektronisch als PDF-Dateien vor:
*  Benutzerhandbuch zu Multisim

e Benutzerhandbuch zu Ultiboard

@ Hinweis Da das Multisim-MCU-Modul nun in NI Multisim enthalten ist, wurde die
Nutzeranleitung zum Multisim MCU-Modul nicht weitergefiihrt. Weitere Einzelheiten zu
Multisim MCU finden Sie im Benutzerhandbuch zu Multisim. Auch das Bauelemente-
handbuch zu Multisim wurde nicht weiter ergédnzt. Um weitere Informationen zu
Bauelementen zu erhalten, sehen Sie sich bitte die Bauelement-Referenzhilfedatei an.

Zum Offnen der Handbiicher wihlen Sie unter Start»Alle Programme»
National Instruments»Circuit Design Suite 10.1»Dokumentation die
gewiinschte Datei aus.

Die folgenden Hilfedateien konnen entweder iiber das Hilfemenii der Soft-
ware oder das Startmenii von Windows getffnet werden:

*  Hilfedatei zur Professional Version von Multisim
*  Hilfe zu Ultiboard
Zum Offnen der Hilfedateien wihlen Sie unter Start»Alle Programme»

National Instruments»Circuit Design Suite 10.1»Dokumentation die
gewiinschte Datei aus.

Die folgenden Hilfedateien sind iiber das Hilfemenii in der Software
verfiigbar:

*  Bauelemente-Ubersicht zur Professional Edition

»  Symboleditor-Hilfe von Multisim (Zugriff iiber Symboleditor)

»  Titelblockeditor-Hilfe von Multisim (Zugriff liber Titelblockeditor)
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